SMART Board™ 8070i
Interactive Display
User's Guide

Extraordinary made simple™ | SMART™
Product registration

If you register your SMART product, we'll notify you of new features and software upgrades.

Register online at smarttech.com/registration.

Keep the following information available in case you need to contact SMART Support.

Serial number: __________________________________________

Date of purchase: ________________________________________

FCC warning
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the manufacturer’s instructions, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Trademark notice
SMART Board, SMART Ink, SMART Notebook, SMART Meeting Pro, DViT, SMART GoWire, smarttech, the SMART logo and all SMART slogans are trademarks or registered trademarks of SMART Technologies ULC in the U.S. and/or other countries. Mac and Macintosh are trademarks of Apple Inc., registered in the U.S. and other countries. Windows is either a registered trademark or a trademark of Microsoft Corporation in the U.S. and/or other countries. VESA is a registered trademark of The Video Electronics Standards Association. HDMI is a trademark or registered trademark of HDMI Licensing LLC. All third-party product and company names may be trademarks of their respective owners.

Copyright notice
© 2011 SMART Technologies ULC. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into any language in any form by any means without the prior written consent of SMART Technologies ULC. Information in this manual is subject to change without notice and does not represent a commitment on the part of SMART.


03/2011
Important information for your interactive display

**WARNING**

- Failure to follow the installation instructions shipped with your SMART product could result in personal injury and product damage which may not be covered by your warranty.

- Don’t open or disassemble the SMART product. You risk electrical shock from the high voltage inside the casing. Opening the casing also voids your warranty.

- Do not stand (or allow children to stand) on a chair to touch the surface of your SMART product. Rather, mount the product at the appropriate height.

- To reduce the risk of fire or electric shock, do not expose the SMART product to rain or moisture.

- If your SMART product requires replacement parts, make sure the service technician uses replacement parts specified by SMART Technologies or parts with the same characteristics as the original.

- Ensure that any cables extending across the floor to your SMART product are properly bundled and marked to avoid a trip hazard.

- Do not insert objects inside the cabinet ventilation holes, because they could touch dangerous voltage points and cause electric shock, fire or product damage which may not be covered by your warranty.

- Do not place any heavy objects on the power cable. Damage to the cable could cause shock, fire or product damage which may not be covered by your warranty.

- Use only extension cords and outlets into which this product’s polarized plug can be fully inserted.

- Use the power cable provided with this product. If a power cable is not supplied with this product, please contact your supplier. Use only power cables that match the AC voltage of the power outlet and that comply with your country’s safety standards.

- If the glass is broken, do not touch the liquid crystal. To prevent injury, handle glass fragments with care when disposing of them.
• Do not move or mount the interactive display by connecting rope or wire to its handles. Because the interactive display is heavy, rope, wire or handle failure could lead to personal injury.

• To prevent personal injury, do not attempt to mount or carry the interactive display using your own strength. Instead, use a lifting device with the included M12 attachable eyebolts. The eyebolts are not post-installation hardware.

• Only use VESA®-approved mounting hardware.

• Lamps in this product contain mercury. Handle lamps with care. Comply with local, state or federal law when recycling or disposing of lamps from this product.

• Disconnect all power cables for your interactive display from the wall outlet and seek assistance from qualified service personnel when any of the following occurs:
  ○ The power cable or plug is damaged
  ○ Liquid is spilled into the interactive display
  ○ Objects fall into the interactive display
  ○ The interactive display is dropped
  ○ Structural damage such as cracking occurs
  ○ The interactive display behaves unexpectedly when you follow operating instructions

⚠️ CAUTION ⚠️

• Before you clean your SMART product, shut down or disconnect the computer. Otherwise, you may scramble the desktop icons or inadvertently activate applications when you wipe the screen.

• Avoid setting up and using the SMART product in an area with excessive levels of dust, humidity and smoke.

• If your SMART product requires replacement parts, make sure the service technician uses replacement parts specified by SMART Technologies or parts with the same characteristics as the original.

• Make sure an electrical socket is near your SMART product and remains easily accessible during use.

• The external power supply needs to meet the Limited Power Source (LPS) requirements of CSA/UL/IEC/EN 60950-1, when required.
This SMART product should be used only with European TN and TT power distribution systems.

It is not suitable for older, IT-type power distribution systems found in some European countries. "This system (IT-type) is widely used isolated from earth, in some installations in France, with impedance to earth, at 230/400V, and in Norway, with voltage limiter, neutral not distributed, at 230V line-to-line." (IEC 60950:1999)

Contact qualified personnel if you're uncertain of the type of power system available where you're installing your SMART product.

- You must connect the USB cable that came with your SMART Board interactive whiteboard to a computer that has a USB compliant interface and that bears the USB logo. In addition, the USB source computer must be compliant with CSA/UL/EN 60950 and bear the CE mark and CSA and/or UL Mark(s) for CSA/UL 60950. This is for operating safety and to avoid damage to the SMART Board interactive whiteboard.
Contents

Important information for your interactive display.......................................................... i

Chapter 1: About your interactive display ........................................................................... 1
  Feature highlights .............................................................................................................. 1
  Interactive display components ......................................................................................... 3

Chapter 2: Installing your interactive display .................................................................... 9
  Environmental requirements ............................................................................................. 9
  Wall-mounting your interactive display ........................................................................... 10

Chapter 3: Connecting computers and peripheral devices to your interactive display .... 15
  Installing the speakers ..................................................................................................... 16
  Interactive display USB and video connections ............................................................... 17
  Connecting to power and your room computer ................................................................. 19
  Installing a guest laptop connection ................................................................................ 20
  Disabling the USB receptacle on the side connection panel ........................................... 22
  Connecting peripheral devices to your interactive display ............................................. 23

Chapter 4: Installing SMART software .............................................................................. 25
  Installing SMART Meeting Pro software ....................................................................... 25
  Installing SMART Notebook software ............................................................................ 26

Chapter 5: Using your interactive display ........................................................................ 29
  Turning on and turning off your interactive display ....................................................... 30
  Using the infrared remote control .................................................................................. 30
  Getting started with your SMART Board interactive display ......................................... 34
  Working with Ink Aware programs .................................................................................. 43
  Playing audio files on your interactive display .............................................................. 50
  Using the USB receptacle ............................................................................................... 51

Chapter 6: Using guest laptops with your interactive display .......................................... 53
  Interactive display USB and video connections ............................................................... 54
  Making a guest laptop connection ................................................................................... 55
  Making a side laptop connection ..................................................................................... 55
  Using a SMART GoWire auto-launch cable .................................................................... 56

Chapter 7: Maintaining your interactive display ............................................................... 59
  Updating your SMART Software and firmware ............................................................... 59
  Calibrating your interactive display ................................................................................ 61
  Orienting your interactive display ................................................................................... 62
Replacing a pen nib .......................................................... 62
Cleaning the screen ......................................................... 63
Cleaning the camera windows and reflective tape .................. 63
Maintaining ventilation .......................................................... 64
Preventing condensation ....................................................... 64
Checking the interactive display installation ......................... 65
Removing your interactive display ........................................ 65
Transporting your interactive display .................................... 66

Chapter 8: Troubleshooting for your interactive display ............. 67
  Resolving image issues ......................................................... 67
  Resolving touch control and digital ink issues ...................... 70
  Resolving audio issues .......................................................... 74
  Resolving remote control issues ......................................... 74
  Resolving issues using the SMART Connection Wizard .......... 75
  Resolving issues using SMART Board Diagnostics ............... 75

Appendix A: Adjusting video settings with the on-screen display menu ......................................................... 77
  Changing settings in the on-screen display menu .................... 77
  Main menu settings .............................................................. 78

Appendix B: Hardware environmental compliance .................. 85
  Waste Electrical and Electronic Equipment regulations (WEEE directive) .......................................................... 85
  Restriction of Certain Hazardous Substances (RoHS directive) .......................................................... 85
  Batteries ........................................................................ 85
  Packaging ........................................................................ 86
  Covered electronic devices .................................................. 86
  China’s Electronic Information Products regulations ............. 86
  U.S. Consumer Product Safety Improvement Act ................. 86
Chapter 1
About your interactive display

Feature highlights

Commercial-grade, touch-enabled display ................................................................. 2
Elegant, sophisticated design ..................................................................................... 2
Software ....................................................................................................................... 2
Dual sketch capabilities ............................................................................................. 2
SMART Ink™ ................................................................................................................. 2
Touch and gestures .................................................................................................. 2
Durable surface ........................................................................................................... 2

Interactive display components

Front view .................................................................................................................... 3
LCD screen ............................................................................................................... 3
Camera and reflective tape channel ......................................................................... 3
Pen and eraser holders ............................................................................................... 4
Color select module .................................................................................................. 4
Front control panel .................................................................................................... 4
Infrared remote control ............................................................................................. 5

Left side view ............................................................................................................. 5
Menu control panel ................................................................................................... 5
USB receptacle .......................................................................................................... 5
Side laptop terminal panel ....................................................................................... 5

Back view .................................................................................................................. 6
Bottom terminal panel ............................................................................................... 6
Inside terminal panel ................................................................................................ 7
Audio terminal panel ................................................................................................. 7

Feature highlights
Your SMART Board™ 8070i interactive display features SMART's proprietary DVIT™ (Digital Vision Touch) technology on an LCD screen which enables you to select, write and erase on the interactive surface. It enables you to do everything you can do at your computer—open and close applications, conference with others, create new documents or edit existing ones, visit websites, play and manipulate video clips and more—just by touching the interactive surface. Two users can also draw on the interactive surface at the same time, and you can use an array of gestures within applications.
CHAPTER 1
About your interactive display

You can also write over any application in digital ink using a pen tray pen or your finger, and then save these notes for future reference and distribution.

Commercial-grade, touch-enabled display
The 8070i is a 70" commercial-grade high-definition display powered by SMART's proprietary DViT (Digital Vision Touch) technology, delivering a superior touch experience and bright, crisp 1080p images that make it easy to present and work with complex data.

Elegant, sophisticated design
The professional design and crisp, eye-catching visuals of the 8070i make it perfect for any high-end workspace.

Software
To use all the features of your interactive display described in this guide, go to smarttech.com/downloads and ensure that you have the lastest version of SMART software and SMART Product Drivers installed on your computer.

Dual sketch capabilities
Two people can each pick up a pen and draw on the interactive surface at the same time, providing a higher degree of interactivity.

SMART Ink™
The SMART Ink™ feature smoothes out the appearance of the digital ink, which improves the legibility of your handwriting as you write over applications, websites and videos. The ink becomes an object that you can move and manipulate.

Touch and gestures
You can perform mouse functions with your finger, and write and erase digital ink with a pen tray pen or the eraser. The object awareness feature enables you to pick up a pen, and then write, select or erase without replacing the pen.

Durable surface
The 8070i features a hardened glass display.
Interactive display components

Front view
The front of your interactive display includes the LCD screen, the cameras and reflective tape channel, the pen holders with the pens, the eraser holder with an eraser and the color select module.

![Diagram of interactive display components]

**LCD screen**
The screen is 61" W × 34 1/4" H (154.9 cm × 87.2 cm), with a 70" (178 cm) diagonal, 16:9 format.

For information on cleaning your LCD screen, see page 63.

**Camera and reflective tape channel**
The interactive display screen is bordered by a channel that contains reflective tape. Each corner has a camera that tracks finger and pen positions across the screen. For information on cleaning your camera windows and reflective tape, see page 63.

⚠️ **CAUTION**
- Do not damage or remove the reflective tape.
- Keep the reflective tape dry.

اهل **IMPORTANT**
- Do not attach items such as adhesive notes to the screen because they will interfere with the cameras.
- Do not place anything in the channel because it will interfere with the cameras.
CHAPTER 1
About your interactive display

Pen and eraser holders
The bottom bezel contains magnetic holders for two pens and an eraser. Removing a pen or the eraser from the holders activates it and enables you to either draw or erase digital ink.

⚠️ CAUTION
Ensure your pen or eraser is centered on the holder when returning the pen or eraser to holder to prevent the pen or eraser from falling and causing product damage.

Color select module
The color select module enables you to access the help function, open the on-screen keyboard, select pen color, activate the right-click and orient the interactive display.

Front control panel
The front control panel contains the volume control, mute, input and power buttons, as well as the status light and infrared remote control sensor.

⚠️ IMPORTANT
Do not cover or block this area or you could have reduced use of the infrared remote control.

In normal use:
- The volume, mute and input buttons are blue.
- The power button is green.
- The status light is green.

For information on diagnosing issues using the front control panel lights, see page 67.
Infrared remote control
The infrared remote control enables you to turn on and turn off your interactive display, change the input source, adjust the volume, access the on-screen menu and more. For more information on the infrared remote control, see page 30.

Left side view
The left side of your interactive display has the menu control panel and the side terminal panel.

Menu control panel
The menu control panel enables you to access the on-screen display menu to adjust display and audio settings. For more information on the on-screen display menu, see page 77.

USB receptacle
The USB receptacle takes a USB type A connector, such as a USB memory drive. For more information on this receptacle, see page 51.

NOTE
You can disable this USB receptacle so that it doesn’t connect to the room computer. For instructions, see page 22.

Side laptop terminal panel
The side laptop terminal panel has USB and HDMI™ receptacles for connecting a side laptop. For more information on this terminal panel, see page 55.
Back view

The back of the interactive display includes the bottom terminal panel, the inside terminal panel and the audio connection terminal panel.

**IMPORTANT**

Connect all required cables before you install your interactive display.

Bottom terminal panel

The bottom terminal panel contains the main power switch and several connections, including both touch control connections and connections for auxiliary input and output devices, such as DVD players, Blu-ray™ players and VCRs.
**CAUTION**

The AC power outlet is designated for a component of the SMART Board 8070i interactive display collaboration appliance system. Use this power outlet only as designated by documentation for that system. Using this power outlet for other items could damage the interactive display.

**Inside terminal panel**
The inside terminal panel is on the left side of the interactive display and contains the touch control USB connections and the room control input and output. For more information on the touch control USB connections, see page 53.

**Audio terminal panel**
This panel contains the speaker wire connections and the wired remote control receptacles.

**IMPORTANT**
Do not connect RCA speaker plugs to the wired remote control receptacles. You will disable the infrared remote control while anything is inserted into these receptacles.
Chapter 2
Installing your interactive display

Environmental requirements .......................................................... 9
Wall-mounting your interactive display .......................................... 10
  Important mounting considerations for trained installers .............. 11
  Choosing a mounting location ...................................................... 12
  Choosing a mounting height for your interactive display .......... 13

You require a team of professional installers equipped with a lifting device to install your interactive display. Consult the SMART Board 8070i Interactive Display Installation Guide (smarttech.com/kb/155314) for more detailed instructions.

This chapter provides additional considerations and details for installing your interactive display.

**IMPORTANT**

Because the connection points might not be accessible after wall-installation, consider connecting cables for speakers, computers and peripheral devices while the interactive display is suspended from the lifting device. For more information, see page 15.

Environmental requirements

Before installing your interactive display, review the following environmental requirements. For more detailed information, see the SMART Board 8070i Interactive Display Specifications (smarttech.com/kb/155318).

<table>
<thead>
<tr>
<th>Environmental requirement</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power requirements</td>
<td>.2A–3.7A at 100V–240V AC, 50 Hz–60 Hz</td>
</tr>
<tr>
<td>Power consumption at 25°C</td>
<td>Typically up–530 W (brightness at 70% and volume at 40), maximum 580 W (brightness and volume at maximums)</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>41°F–95°F (5°C–35°C)</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>-4°F–140°F (-20°C–60°C)</td>
</tr>
<tr>
<td>Humidity</td>
<td>5%–80% relative humidity, non-condensing</td>
</tr>
</tbody>
</table>
### Environmental requirement

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ventilation</td>
<td>Maintain a 4” (10 cm) ventilation area around your interactive display to enable its cooling fans to operate. Do not store or operate your interactive display in dusty environments because dust could interfere with the product’s ventilation and cooling.</td>
</tr>
</tbody>
</table>
| Water and fluid resistance | • Intended for indoor use only. Doesn’t meet any salt-spray or water ingress requirements.  
  • Don’t pour or spray liquids directly onto the interactive display or any of its sub-components. These liquids might get into areas where they could damage sensitive electronic components. Refer to page 63 for detailed instructions on cleaning your interactive display. |

---

### Wall-mounting your interactive display

Use a team of trained, professional installers equipped with a lifting device to install your interactive display.

**WARNING**

- Improper installation can result in personal injury or product damage.
- Your interactive display weighs 262 lb. (119 kg). Refer to local building codes to ensure your installation area can support this weight.

**CAUTION**

Do not allow the weight of your interactive display to rest on the color select module because it is not designed to support product weight. Attach other components while your interactive display is either still in its packaging or suspended from a lifting device to prevent the weight of your interactive display from damaging the color select module.

**IMPORTANT**

Save all product packaging so that it is available if you need to transport your interactive display. If your original packaging is not available, you can purchase new product packaging from your authorized SMART reseller.
Important mounting considerations for trained installers

Consider the following when mounting your interactive display on a wall:

- Plan your workflow to include cabling because some cable attachment points might not be accessible post-installation.

![IMPORTANT]

**IMPORTANT**

Speakers must be attached and speaker wires connected to your interactive display before it is wall-mounted. For more information, see page 16.

- To wall-mount your interactive display, you require a standard VESA 400 mm × 400 mm mounting plate, not included.

- Attach the included M12 eyebolts and washers to assist in mounting.

![WARNING]

**WARNING**

- In order to aid in mounting or carrying, a lifting device must be used in conjunction with the M12 attachable eyebolts. Do not attempt to mount or carry the display using your own strength because your interactive display could fall and cause personal injury.
- Use VESA-approved mounting hardware. Remove the M12 eyebolts after installation.

- Inspect the installation location to ensure that it can support the weight of your interactive display.

- Use M8 screws to fasten the wall bracket. The length of the screws must be 14-15 mm plus the thickness of the bracket and the washer. If using screws longer than 14-15 mm, ensure sufficient depth.

- Recommended fasten force is 1125-1375 N·cm.
Refer to the instructions included with the mounting equipment for more detailed information.

Choosing a mounting location
Consider the following when you select a location for your interactive display:

- The wall must be strong enough to support your interactive display and the mounting accessories. Your interactive display weighs 262 lb. (119 kg).
- Do not install your interactive display in a location where a door or gate can hit it.
- Do not install your interactive display in an area where it will be subjected to strong vibrations or dust.
- Do not install your interactive display near where the main power supply enters the building.
- Ensure adequate ventilation or provide air conditioning around your interactive display so that heat can flow away from the unit and mounting apparatus.
- When mounting your interactive display in a recessed area leave at least 4" (10 cm) of space between your interactive display and the recess walls to enable ventilation and cooling.
Choosing a mounting height for your interactive display
Consider the general height of your user community when you choose the mounting height for your interactive display.
Chapter 3
Connecting computers and peripheral devices to your interactive display

This chapter includes information on connecting your interactive display to computers and other peripheral devices.

 chambre des comptes  IMPORTANT

Because the cable connection points might not be accessible after wall-installation, consider connecting these devices while the interactive display is suspended from the lifting device.
Installing the speakers

Your interactive display comes with two 15 W speakers.

To install the speakers

1. Attach the speakers to the side of the interactive display with the included screws.
2. Connect the speaker wires to the speaker connections on the audio connection panel.

**IMPORTANT**

Do not connect the speakers to the wired remote control receptacles. You will disable the remote control while anything is inserted into these receptacles.
CHAPTER 3
Connecting computers and peripheral devices to your interactive display

Interactive display USB and video connections
You can connect three computers to your interactive display. Typically you will have one installed room computer and two options to connect laptops.

User view
This configuration diagram shows the three suggested computer connections.

Interactive display touch control and video input connections
The following table shows which touch-control USB connection corresponds with which video input for each computer connection.

<table>
<thead>
<tr>
<th>Touch control</th>
<th>Video input</th>
<th>Installation steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room computer USB 1 (Inside panel)</td>
<td>VGA</td>
<td>page 19</td>
</tr>
<tr>
<td>Guest laptop connection USB 2 (Inside panel)</td>
<td>RGB/HV</td>
<td>page 20</td>
</tr>
<tr>
<td>Side laptop connection USB 3 (Side panel)</td>
<td>HDMI2</td>
<td>page 55</td>
</tr>
</tbody>
</table>

**NOTE**
A wire management bundle for the guest laptop connection is available from your authorized SMART reseller. This 16’ (5m) bundle includes a USB cable and a RGB/HV to VGA video cable. The part number is WMB-SBID.
CHAPTER 3
Connecting computers and peripheral devices to your interactive display

Cabling detail
These are the suggested connection points.
Connecting to power and your room computer

Your room computer is the default computer for your interactive display. Connect this computer to your interactive display with a VGA cable and a USB cable.

Room computer connection diagram

To connect your interactive display to power and your room computer

1. Connect the included VGA cable from your computer to the VGA connection on the bottom terminal panel.

2. Connect the included USB cable from the USB 1 receptacle on the inside terminal panel of the interactive display to a USB receptacle on the computer.

3. Connect the included power cable from the AC IN connector on the bottom terminal panel to a power outlet.

4. Connect the power cable from your computer to a power outlet.

5. Turn on the main power switch on the bottom terminal panel, and then press the power button on the front control panel.

6. Using the remote control or the input button on the front control panel, set the interactive display’s input source to VGA.

7. Turn on your computer.
Installing a guest laptop connection

You can install cabling that enables you to connect a laptop to your interactive display from another location in the room such as on a conference table. By installing this connection, you make use of connection points that might not be accessible when your interactive display is wall-mounted.

You require a USB cable and a RGB/HV to VGA cable to install the guest laptop connection. You can purchase a wire bundle that includes these two connectors from your authorized SMART reseller. Refer to the interactive display specifications document for ordering information.

This is an installed solution since the connection points on the interactive display can be out of reach after wall-installation. You may install the cables and run them through floors or walls to a nearby table.

Alternatively, your users can connect a laptop to the left side terminal panel using the more accessible side laptop terminal panel. For more information, see page 55.

**WARNING**

Ensure that any cables extending across the floor to your SMART product are properly bundled and marked to avoid a trip hazard.

**NOTE**

You do not require a laptop present to install this cabling.
To install a guest laptop connection location

1. Connect a USB cable to the USB 2 receptacle on the inside terminal panel, and then run the cable to the laptop connection location, such as beside the interactive display or on a conference table.
CHAPTER 3
Connecting computers and peripheral devices to your interactive display

2. Connect a 5-BNC to VGA video cable to the RG/BHV interactive display bottom terminal panel, and then run the VGA end of the cable to the remote connection location as above.

3. Bundle and cover the cables as appropriate to avoid a trip hazard.

To connect and use a guest laptop using this installed connection, see page 55.

Disabling the USB receptacle on the side connection panel
You can connect a USB drive or other USB device to the USB receptacle on the side of your interactive display, and then access that device from the room computer through the USB 1 receptacle. For more information, see page 51.

You can also disable this USB receptacle so that doesn’t access any of the computers connected to your interactive display.

⚠️ CAUTION
Disconnect the power supply for your interactive display before you disable the USB receptacle.

To disable the USB receptacle

1. Locate the oval cut-out on the back of your interactive display. It is at the same height as the USB receptacle and very close to the receptacle.

2. Rotate the top of the cut-out using needle-nose pliers, and then grasp the bottom edge of the cut-out with the pliers.

3. Pry the cut-out away from your interactive display.

    You can see a black jumper on the circuit board inside the panel.
4. Pull the black jumper off of the circuit board with the pliers.

⚠️ **CAUTION**
To prevent damage to the circuit board, do not touch the circuit board with the pliers.

⚠️ **IMPORTANT**
You can re-install the jumper to enable the USB receptacle.

**Connecting peripheral devices to your interactive display**
Connect peripheral devices to your interactive display’s bottom terminal panel.

**Bottom terminal panel**
CHAPTER 3
Connecting computers and peripheral devices to your interactive display

To connect a peripheral device

1. Turn off your interactive display using the power button on the front control panel.
2. Ensure your peripheral device is connected to its power source and is turned off.
3. Connect your peripheral device’s input cables to the appropriate connectors on the bottom terminal panel.
4. Press the power button on the front control panel.
5. Turn on your peripheral device.

CAUTION

The AC power outlet is designated for a component of the SMART Board 8070i interactive display collaboration appliance system. Use this power outlet only as designated by that system’s documentation. Using this power outlet for other items could damage the interactive display.
Chapter 4
Installing SMART software

Installing SMART Meeting Pro software ........................................................................ 25
Installing SMART Notebook software .......................................................................... 26

You need to install SMART software on the computer that’s connected to the interactive display in order to use your interactive display.

SMART software includes:

- SMART Product Drivers, which enable touch interactivity and digital ink
- SMART Meeting Pro™ software
  OR
  SMART Notebook™ collaborative learning software

NOTE
For laptops that will only occasionally be used for your interactive display, you can use a SMART GoWire auto-launch cable instead of installing SMART software. For more information, see page 56.

Installing SMART Meeting Pro software
The SMART Meeting Pro software download includes two components:

- SMART Product Drivers
- SMART Meeting Pro software

This software requires a computer with a Windows® operating system. For a complete list of SMART Meeting Pro software system requirements, see the SMART Meeting Pro software release notes (smarttech.com/kb/141332).
Important

Your product packaging includes an activation key for SMART Meeting Pro software. Retain this activation key for your records.

To download SMART Meeting Pro software

2. Click the SMART Meeting Pro software link.
3. Click Download.
4. Follow the on-screen instructions to save the executable file to your desktop.

To install SMART Meeting Pro software and SMART Product Drivers

1. Double-click the executable file.
2. Follow the on-screen instructions. You'll be prompted to enter your product activation key. 
   Register your interactive display.
3. Click the SMART Meeting Pro icon in the notification area, and then select Check for Updates.
   The SMART Product Update window appears.
4. Follow the on-screen instructions to update your SMART Meeting Pro software and SMART Product Drivers to their latest versions.

Installing SMART Notebook software

The SMART Notebook software CD includes two components:

- SMART Product Drivers
- SMART Notebook software

For a complete list of SMART Notebook software system requirements, see the SMART Notebook software release notes (smarttech.com/kb/126571).

Important

Connect to the Internet before you install SMART software so that you can obtain a software activation key and download software updates.
To install SMART Notebook software and SMART Product Drivers

1. Place the included installation CD in your computer’s CD tray.
   The installation wizard appears.

2. Follow the on-screen instructions. You’ll be prompted to enter your product activation key.
   Register your interactive display online using the serial number found underneath its color select module.

3. Click the SMART Board icon in the notification area (Windows operating systems) or the Dock (Mac operating system software), and then select Check for Updates.
   The SMART Product Update screen appears.

4. Follow the on-screen instructions to update your SMART Notebook software and SMART Product Drivers to their latest versions.
Chapter 5
Using your interactive display

Turning on and turning off your interactive display .................................................. 30
Using the infrared remote control ............................................................................ 30
   Placing or replacing batteries in the remote control ............................................. 31
   Infrared remote control sensor ........................................................................... 32
   Infrared remote control buttons .......................................................................... 33
Getting started with your SMART Board interactive display ..................................... 34
   Writing or drawing digital ink ................................................................................ 34
      Using Locked Ink mode .................................................................................... 35
      Changing pen settings ...................................................................................... 35
   Erasing digital ink ................................................................................................... 36
      Changing eraser settings ................................................................................... 36
   Manipulating objects ............................................................................................. 37
   Browsing ................................................................................................................. 40
   Entering text onto the interactive display ............................................................. 43
Working with Ink Aware programs ............................................................................ 43
   Viewing a list of Ink Aware programs .................................................................... 43
   Using Ink Aware features in Word ......................................................................... 44
   Using Ink Aware features in Excel ......................................................................... 45
   Using Ink Aware features in PowerPoint ............................................................... 45
   Disabling Ink Aware ............................................................................................... 46
Working with non-Aware programs ........................................................................... 47
   Saving your notes ................................................................................................... 47
   Customizing the transparent layer ......................................................................... 48
   Closing the transparent layer ................................................................................ 49
   Clearing all notes ..................................................................................................... 49
   Restoring cleared notes ......................................................................................... 50
Playing audio files on your interactive display .......................................................... 50
Using the USB receptacle ......................................................................................... 51

This chapter includes information on how to use your interactive display, turn on and turn off your interactive display, control your computer by touching the screen, use the remote control, and more.
Turning on and turning off your interactive display

To turn on your interactive display

1. Turn on your computer.
2. Press the power button on the front control panel.
   OR
   Press the POWER ON button on the remote control.
   Your computer's logon screen or desktop appears on your interactive display.

   **IMPORTANT**
   If the power button light on the front control panel is off, either the interactive display is not plugged in or the main power switch on the bottom terminal panel is turned off. To find the main power switch, see page 3.

To turn off your interactive display

1. Shut down your computer.
2. Press the power button on the front control panel.
   OR
   Press the STANDBY button on the remote control.

Using the infrared remote control

The infrared remote control enables you to turn on and turn off your interactive display, change the input source, change the volume, and more. You can also use the remote control to open the on-screen menu, and then change the monitor’s settings.

If the remote control doesn’t respond, see page 74.

**CAUTION**

- Do not subject the remote control to strong shock.
- Keep the remote control away from liquids. If it gets wet, wipe it dry immediately.
- Do not expose the remote control to heat or steam.
- Do not open any part of the remote control other than the battery compartment.
**IMPORTANT**

The remote control system does not function when strong light strikes the remote control sensor or when there is an object between the remote control and its sensor.

Placing or replacing batteries in the remote control

Your remote control requires two 1.5V AA batteries.

**WARNING**

To reduce the risk associated with leaking batteries:

- use only AA type batteries
- do not mix used and new batteries
- orient the battery’s plus (+) and minus (-) terminals according to the markings found on the remote control
- do not leave the batteries in the remote control for an extended period
- do not heat, disassemble, short or recharge the batteries, or expose them to fire or high temperature
- avoid eye and skin contact if batteries have leaked
- dispose of exhausted batteries and product components in accordance with applicable regulations

To place batteries in the remote control

1. Press the tab on the underside of the remote control, and then slide it to open the cover.
2. Remove the batteries if they are present.
3. Insert two 1.5V AA batteries in the remote control. Ensure the + and - markings on the batteries align with the markings in the remote control.
4. Replace the cover.
Infrared remote control sensor

The infrared remote control sensor is located on the front control panel. It enables you to control your interactive display from an angle of 30° and within a distance of 23' (7 m) using the included remote control.

**IMPORTANT**

The remote control might not function when the infrared remote control sensor is blocked or when it is in direct sunlight or strong lighting.
Infrared remote control buttons
The remote control enables you to access on-screen menus and change display and input settings.

Use the remote control’s POWER ON button turn on your interactive display and the STANDBY button to turn off your interactive display.

Use the remote control’s input buttons to change input sources when switching between the room computer and guest laptops.

<table>
<thead>
<tr>
<th>Number</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>POWER ON STANDBY</td>
<td>Turns on your interactive display</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Turns off your interactive display</td>
</tr>
<tr>
<td>2</td>
<td>Input buttons</td>
<td>Selects input signal for the display</td>
</tr>
<tr>
<td>3</td>
<td>PICTURE MODE</td>
<td>Selects picture mode</td>
</tr>
<tr>
<td>4</td>
<td>ASPECT</td>
<td>Selects picture aspect</td>
</tr>
<tr>
<td>5</td>
<td>SOUND</td>
<td>Selects artificial surround sound</td>
</tr>
<tr>
<td>6</td>
<td>Number pad</td>
<td>Press buttons to set and change passwords, change channel or make settings</td>
</tr>
<tr>
<td>7</td>
<td>ENT</td>
<td>Enter</td>
</tr>
<tr>
<td>8</td>
<td>DISPLAY</td>
<td>Turns the on-screen display menu on and off</td>
</tr>
<tr>
<td>9</td>
<td>MENU</td>
<td>Turns the menu mode on and off</td>
</tr>
<tr>
<td>10</td>
<td>AUTO SET UP</td>
<td>Enters auto setup menu</td>
</tr>
<tr>
<td>11</td>
<td>EXIT</td>
<td>Returns to previous menu</td>
</tr>
<tr>
<td>12</td>
<td>Up/Down</td>
<td>Moves the highlighted area up or down to select items within the on-screen display menu</td>
</tr>
<tr>
<td>13</td>
<td>+/-</td>
<td>Increases or decreases the adjustment level within the on-screen display menu</td>
</tr>
</tbody>
</table>
### Getting started with your SMART Board interactive display

Using your SMART Board interactive display, you can write, draw and erase digital ink, manipulate objects and browse content on the screen.

### Writing or drawing digital ink

Using the pen supplied with your interactive display, you can write or draw digital ink over SMART Meeting Pro software and other programs.

#### NOTE

How the digital ink you write or draw over a program is included in that program depends on whether the program is Ink Aware or not. For more information, see Working with Ink Aware programs on page 43 and Working with non-Aware programs on page 47.

#### To write or draw digital ink

1. Pick up the pen.
2. Write or draw on the screen.

#### TIP

Don’t rest your elbow or the palm of your hand on the screen while you’re writing.
Using Locked Ink mode
Locked Ink mode enables you to write or draw digital ink using large objects, including eraser-sized objects.

To use Locked Ink mode
Press and hold a color button down on the color select module until the light flashes.

To end Locked Ink mode
Press any not-flashing button on your color select module.

Changing pen settings
You can change your pen settings to change line size and fill effects.

To change pen settings
1. Press the SMART Board icon or in the notification area, and then select Control Panel.
   OR
   Press the SMART Meeting Pro icon in the notification area, and then select Control Panel.
2. Press SMART Hardware Settings.
3. Select Pen and Button Settings in the drop-down list.
4. Press Black Pen Settings to customize the black pen.
   OR
   Press Blue Pen Settings to customize the blue pen.
   OR
   Press Red Pen Settings to customize the red pen.
   OR
   Press Green Pen Settings to customize the green pen.
   The Properties dialog box appears.
5. Press Line Style.
6. Adjust the color, thickness, line end and line style.
7. Press Fill Effects.
8. Adjust the transparency.
9. Press **Save Tool Settings** to save your settings.

10. Repeat steps 4 through 9 if you want to customize other pens.

11. Press **OK** to close the control panel.

**Erasing digital ink**

- **To erase digital ink**
  
  Pick up the eraser, and then press the eraser on the screen and move it over the digital ink you want to erase.

  OR

  Using your flattened hand, palm or fist, press the screen and move your hand over the digital ink you want to erase.

**Changing eraser settings**

You can change eraser size for either a larger or smaller eraser area.

- **To change eraser settings**
  
  1. Press the **SMART Board** icon in the notification area, and then select **Control Panel**.

  OR

  Press the **SMART Meeting Pro** icon in the notification area, and then select **Control Panel**.

  2. Press **SMART Hardware Settings**.

  3. Select **Pen and Button Settings** in the drop-down list.

  4. Press **Eraser Settings**.

  5. Select an eraser size.

  6. Press **OK** to save your settings.

  7. Press **OK** to close the control panel.
Manipulating objects
Objects include icons, buttons, links and other components of programs that appear on your screen. You can manipulate these objects using your interactive display as described below.

■ To select or deselect an object
Quickly press and release the object.

NOTES
- This gesture performs a standard mouse click.
- This gesture starts programs if your operating system is set to start applications on a single click.

■ To double-click an object
Quickly press and release the object twice in the same spot.

NOTE
This gesture starts programs if your operating system is set to start applications on a double-click.
CHAPTER 5
Using your interactive display

To right-click or Control-click an object
Press and hold the object.

OR
Using two fingers on the same hand, press and hold the object with your left finger, and then press the screen once with your right finger.

OR
Press the Right-Click button on the pen tray, and then press the object.

To move an object
1. Press and hold the object.
2. Keeping your finger on the screen, slowly move the object.
3. When you reach the position you want to move the object to, release your finger.
To resize an object

1. Using one finger on each hand, press the screen at opposite ends of the object.
2. Drag your fingers in opposite directions to enlarge the object.

OR

Drag your fingers toward each other to reduce the object.

To rotate an object

1. Using one finger on each hand, press the screen at opposite ends of the object.
2. Rotate your fingers in the direction you want to rotate the object.
When you reach the angle you want to rotate the object to, release your fingers.

**Browsing**

In addition to manipulating objects, you can browse content on your screen.

- **To display the next page**
  
  Press the screen, and then quickly press again directly to the right of that point.

  OR

  Quickly flick your finger right across the screen.

- **To display the previous page**
  
  Press the screen, and then quickly press again directly to the left of that point.
CHAPTER 5
Using your interactive display

OR

Quickly flick your finger left across the screen.
To zoom in or out

1. Using one finger on each hand, press the screen at opposite ends of the object.
2. Drag your fingers in opposite directions to zoom in.

OR

Drag your fingers toward each other to zoom out.

To pan horizontally or vertically

1. Using two fingers on the same hand, press and hold the screen.
2. Keeping your fingers on the screen, move up, down, left or right.
3. When you reach the area you want to view, release your fingers.

**Entering text onto the interactive display**

You can enter text into text boxes on the interactive display with either a keyboard attached to your computer or the on-screen keyboard.

**To enter text**

1. Select the area where you want to enter text.
2. Either type with your laptop keyboard or a keyboard connected to your computer.
   
   OR
   
   Press the keyboard button on the pen control panel on the interactive display.
   
   The on-screen keyboard appears and you can type characters by touch.
3. Enter text.

**Working with Ink Aware programs**

Many popular third-party programs are Ink Aware (that is, they’re integrated with SMART Product Drivers). If a program is Ink Aware, whatever you write or draw on the interactive product becomes a component of the program file.

Ink Aware software products include Word, Excel and PowerPoint.

**Viewing a list of Ink Aware programs**

You can open and view a list of Ink Aware programs in the SMART control panel.

**To view a list of Ink Aware programs**

1. Press the SMART Board icon in the notification area, and then select Control Panel.
   
   OR
CHAPTER 5
Using your interactive display

Press and hold SMART Board Tools icon in the Dock, and then select Control Panel.

OR

Press the SMART Meeting Pro icon in the notification area, and then select Control Panel.

2. Press Configure SMART Tools.

3. Press Ink Aware Program Settings.

The Aware window appears.

You can enable or disable Ink Aware for any of the programs in the list (see Disabling Ink Aware on page 46).

- If a check mark appears in the Aware Enabled column, the program is currently Ink Aware.
- If the program is currently open, Running appears in the Status column.

Using Ink Aware features in Word
Microsoft Word software is Ink Aware, which means that it’s integrated with SMART Product Drivers. What you write or draw on your interactive product’s screen becomes a part of the Word document.

To write or draw in Word

1. Display the Word document you want to write in.

2. Write or draw on your interactive product’s screen.

The Aware Tools toolbar appears. Depending on your version of Word, this toolbar either floats on top of the program or appears with the program’s other toolbars.

![NOTE]

If the Aware Tools toolbar doesn’t appear, select View > Toolbars > SMART Aware Toolbar.

3. Press \( \text{itational} \) to insert your notes into the Word document as graphics.

OR

Press \( \text{ntact} \) to insert your notes into the Word document as typed text.

OR

Press \( \text{virect} \) to take a screen capture of your notes and the Word document.

The screen capture appears in a .notebook file.
CHAPTER 5
Using your interactive display

Using Ink Aware features in Excel
Excel is Ink Aware, which means that it’s integrated with your interactive product. What you write or draw on your interactive product’s screen becomes a part of the Excel spreadsheet.

To write or draw in Excel
1. Display the Excel spreadsheet you want to write in.
2. Write or draw on your interactive product’s screen.
   The Aware Tools toolbar appears. Depending on your version of Excel, this toolbar either floats on top of the program or appears with the program’s other toolbars.

   **NOTE**
   If the Aware Tools toolbar doesn’t appear, select View > Toolbars > SMART Aware Toolbar.

3. Press \( \text{to insert your notes into the Excel spreadsheet as graphics.} \)
   OR
   Press  \( \text{to insert your notes into the Excel spreadsheet as typed text.} \)
   OR
   Press  \( \text{to take a screen capture of your notes and the Excel spreadsheet.} \)

   The screen capture appears in a .notebook file.

Using Ink Aware features in PowerPoint
PowerPoint is Ink Aware, which means that it’s integrated with your interactive product. What you write or draw on the interactive product’s screen becomes a part of the PowerPoint slide show.

To present a PowerPoint slide show on your interactive product
1. Display the PowerPoint file in Slide Show view.
   The PowerPoint slide show and the Slide Show toolbar appear.

2. To display the next slide, press **Next** on the Slide Show toolbar.
   OR
   To display the previous slide, press **Previous** on the Slide Show toolbar.
3. Write or draw on your interactive product’s screen.
4. Do the following:
   - To insert writing into the PowerPoint slide show as typed text, right-click your writing, and then select an Inject...Here option.
   - To insert a drawing into the PowerPoint slide show as an image, press \textit{Menu} on the \textit{Slide Show} toolbar, and then select \textit{Insert Drawing as Image}.
   - To insert a blank page, press \textit{Menu}, and then select \textit{PowerPoint Commands > Add Blank Slide}.
   - To clear notes on the current slide, press \textit{Menu}, and then select \textit{Clear Drawing}.

\begin{itemize}
   \item \textbf{NOTE}
   \end{itemize}

To restore your most recently deleted notes, press \textit{Menu}, and then select \textit{Restore Drawing}.

5. To print the current slide on the computer’s default printer, press \textit{Menu}, and then select \textit{PowerPoint Commands > Print Slide}.

\begin{itemize}
   \item \textbf{NOTE}
   \end{itemize}

The \textit{Print Slide} menu command isn't available if you're using PowerPoint Viewer software because this software allows you to view files on a read-only basis.

Using the options in the \textit{Slide Show} toolbar, you can also end a slide show, open the Floating Tools toolbar, change settings, display the PowerPoint menu, and display a specific slide.

\textbf{Disabling Ink Aware}

You can disable Ink Aware for a specific program or for all programs.

\begin{itemize}
   \item \textbf{To disable Ink Aware}
   \end{itemize}

1. Press the \textit{SMART Board icon} in the notification area, and then select \textit{Control Panel}.
   OR
   Press and hold \textit{SMART Board Tools} icon in the Dock, and then select \textit{Control Panel}.
   OR
   Press the \textit{SMART Meeting Pro icon} in the notification area, and then select \textit{Control Panel}.

2. Press \textit{Configure SMART Tools}. 

\end{itemize}
3. Press **Ink Aware Program Settings**.

   The *Aware* window appears.
   - If a check mark appears in the *Aware Enabled* column, the program is currently Ink Aware.
   - If the program is currently open, *Running* appears in the *Status* column.

   The *Ink Aware Options* window appears.

   If a check mark appears next to a program, the program is currently Ink Aware.

4. Do one of the following:
   - To disable Ink Aware for a program, clear the check box in the *Aware Enabled* column.
   - To disable Ink Aware for all software programs, press *Clear All*.

5. Clear a program’s check box to disable Ink Aware for that program.

6. Press **OK**.

   **NOTE**

   To enable Ink Aware for all programs, open the *Aware* dialog box, and then press *Select All*.

**Working with non-Aware programs**

If a program is non-Aware, whatever you write or draw on your interactive product’s screen appears on a transparent layer (sometimes referred to as an ink layer) over the current program.

To insert your notes into the program as text, right-click and select one of the *Inject ... Here* options in the menu that appears.

After you finish writing and drawing, you can save or clear your notes. If you mistakenly clear your notes, you can restore them.

   **NOTE**

   You can customize the behavior of the transparent layer.

You can close the transparent layer at any time.

**Saving your notes**

If a program is non-Aware, whatever you write or draw on your interactive product’s screen appears on a transparent layer (sometimes referred to as an ink layer) over the current program. You can take a screen capture of your notes and the program.
CHAPTER 5
Using your interactive display

NOTE
You can also customize the transparent layer to automatically save your notes (see Customizing the transparent layer below).

To take a screen capture of your notes

Press Screen Capture in the upper right corner of the screen.
Each screen capture appears as an image in a file.

NOTE
If you want to save your notes but you don’t want to take a screen capture of the entire screen, you can take a screen capture of an area or a window using the Screen Capture toolbar (see Using the Screen Capture toolbar).

Customizing the transparent layer
If a program is non-Aware, whatever you write or draw on your interactive product’s screen appears over the current program on a transparent layer (sometimes referred to as an ink layer). Depending on your settings, this transparent layer can be surrounded by a border and can include Clear, Screen Capture and Close buttons in its upper right corner.

To customize the transparent layer
1. Pick up a pen tray pen.
   A transparent layer appears over the current program.
2. Right-click, and then select Ink Layer Options in the menu that appears.
   The Ink Layer Settings dialog box appears.
3. Select settings for the transparent layer:
   ○ To display the transparent layer without a border, clear the Show border around ink layer check box.
   ○ When you clear all notes from the transparent layer, a message appears in the lower right corner of your screen. You can press this message to restore your notes. To prevent this message from appearing, clear the Allow pop-up balloon messages check box.
   ○ To display the transparent layer without the Screen Capture, Clear or Close buttons in the upper right corner, clear the Show the Screen Capture, Clear and Close buttons check box.
   ○ If you write or draw on the screen, and then left-click, a menu appears. You can select options from this menu to save your notes, clear your notes and close the transparent layer, and more. If you want to disable this menu, select Close ink layer with pointer. If you select this option, you can left-click to clear your notes and close the transparent layer, and the menu doesn’t appear.
   ○ If you want to automatically save your notes, select Always Save Ink. If you select this option, a screen capture of your notes and the program appear on a new page in a .notebook file when you close the transparent layer.

4. Press OK.

Closing the transparent layer
If a program is non-Aware, whatever you write or draw on your interactive product’s screen appears on a transparent layer over the current program. You can close the transparent layer at any time.

NOTES

- If you want to save your notes, take a screen capture before you close the transparent layer (see Saving your notes on page 47).
- You can clear all of the notes from the interactive screen without closing the transparent layer (see Clearing all notes below).

To close the transparent layer

Press Close in the upper right corner of the screen.

Clearing all notes

If a program is non-Aware, whatever you write or draw on your interactive product’s screen appears on a transparent layer (sometimes referred to as an ink layer) over the current program. You can clear your notes at any time.
CHAPTER 5
Using your interactive display

1. NOTES
If you mistakenly clear your notes, you can restore them (see Restoring cleared notes below).

To clear all the notes from the screen
Press Clear in the upper right corner of the screen.

Restoring cleared notes
If you mistakenly clear all notes from your interactive product’s screen, you can restore them. You can also restore notes if you close the transparent layer without saving your notes.

To restore notes after you clear them
Open the Floating Tools toolbar (see Showing, hiding and moving the Floating Tools toolbar), and then press Undo.

To restore notes after you close the transparent layer
A thumbnail appears in the lower-right corner of the screen for approximately five seconds after you clear your notes.
Press the thumbnail image.

Playing audio files on your interactive display
Your interactive display includes two speakers that will play audio files or the audio portion of a video file.

When you play an audio file or a video file on a computer connected to your interactive display, the file is streamed through the touch-control USB connection between your computer and your interactive display, not through the video connection.

IMPORTANT
If your computer uses Mac operating system software, you must set the audio output to USB. For more information, see below.

To switch your Mac computer to USB audio output
1. Press the Apple menu, and then select System Preferences.
2. Select Hardware > Sound.
3. Select the Output tab.
4. Select SBID 8070i/USB.
Using the USB receptacle

You can connect a USB drive or device to the USB receptacle on the left terminal panel on your interactive display, and then access it from the room computer.

**NOTE**

You can disable this USB receptacle so that it doesn't connect to the room computer. For more information, see page 22.

To use the USB receptacle

1. Press the VGA button on the remote control.
   OR
   Press the input button on the front control panel until it is set to VGA.
2. Connect a USB device to the USB receptacle.
Chapter 6
Using guest laptops with your interactive display

Interactive display USB and video connections ................................................................. 54
User view .......................................................................................................................... 54
Interactive display touch control and video input connections ......................................... 54
Making a guest laptop connection ..................................................................................... 55
Making a side laptop connection ....................................................................................... 55
Using a SMART GoWire auto-launch cable ..................................................................... 56
Interactive display USB and video connections

You can connect three computers to your interactive display. Typically you will have one installed room computer and two options to connect laptops.

User view

This configuration diagram shows the three suggested computer connections.

Interactive display touch control and video input connections

The following table shows which touch-control USB connection corresponds with which video input for each computer connection.

<table>
<thead>
<tr>
<th>Touch control</th>
<th>Video input</th>
<th>Installation steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room computer</td>
<td>USB 1 (Inside panel)</td>
<td>VGA</td>
</tr>
<tr>
<td>Guest laptop connection</td>
<td>USB 2 (Inside panel)</td>
<td>RGB/HV</td>
</tr>
<tr>
<td>Side laptop connection</td>
<td>USB 3 (Side panel)</td>
<td>HDMI2</td>
</tr>
</tbody>
</table>

NOTE

A wire management bundle for the guest laptop connection is available from your authorized SMART reseller. This 16’ (5m) bundle includes a USB cable and a RGB/HV to VGA video cable. The part number is WMB-SBID.
CHAPTER 6
Using guest laptops with your interactive display

Making a guest laptop connection
You can connect a laptop to installed USB and video cables that are behind your interactive display. If this cable bundle has not been installed use the guest laptop connection. For more information, see page 55.

**IMPORTANT**
The laptop must have SMART Notebook software or SMART Meeting Pro software installed. If it does not, you will need to connect the laptop to the interactive display using a SMART GoWire auto-launch cable. For more information, see page 53.

**To connect a laptop to the guest laptop connection location**
1. Place the laptop beside the end of the wire bundle at the guest laptop connection.
2. Connect the installed USB cable to a USB receptacle on the laptop.
3. Connect the VGA cable connector to the laptop.
4. Turn on the laptop.
5. Press the RGB/HV button on the remote control.
   OR
   Press the input button on the front control panel to change input source to RGB/HV.

**To return to using the room computer**
Press the VGA button on the remote control.

OR
Press the input button on the front control panel to change the input source to VGA.

Making a side laptop connection
You can connect a laptop to the left side control and terminal panel of the interactive display. This enables the interactive display to display the laptop’s desktop and permit touch interactivity.

**IMPORTANT**
The laptop must have SMART Notebook software or SMART Meeting Pro software installed. If it does not, you will need to connect the laptop to the interactive display using a SMART GoWire auto-launch cable. For more information, see page 53.
### To connect a side laptop

1. Connect an HDMI cable from the laptop’s HDMI to your interactive display’s side laptop terminal panel.
2. Connect a USB cable from the laptop USB connector to your interactive display’s side laptop terminal panel.

<table>
<thead>
<tr>
<th>IMPORTANT</th>
</tr>
</thead>
<tbody>
<tr>
<td>The USB type A receptacle is for USB devices only. Do not connect the laptop to this receptacle.</td>
</tr>
</tbody>
</table>

3. Turn on the laptop.
4. Press the **HDMI** input button on the remote control twice.

   OR

   Press the input button on the front control panel to change the input source to HDMI2.

### To return to using the room computer

1. Press the **VGA** button on the remote control.

   OR

   Press the input button on the front control panel to change the input source to VGA.

2. Disconnect the laptop from the interactive display if required.

### Using a SMART GoWire auto-launch cable

Any computer connected to your interactive display requires SMART software. Typically you will install this software on your room computer so that it is always ready for use (see page 25 for more information).
If you want to connect a laptop that doesn't have SMART software installed, you can connect a SMART GoWire auto-launch cable between the touch-control USB cable from your interactive display and the laptop. This auto-launch cable provides your laptop with both SMART Product Drivers and SMART Meeting Pro software so that you have touch control of your laptop on the interactive display.

**IMPORTANT**

Your interactive display only supports SMART GoWire auto-launch cable for business. It does not support the GoWire SMART Notebook software auto-launch cable.

**To use a SMART GoWire auto-launch cable**

1. Ensure the video cable is connected securely to both your interactive display and your laptop.

   **NOTE**

   The video connection for the side laptop connection is HDMI2. The video connection for the guest laptop connection is RGB/HV.

2. Ensure the USB cable for your laptop is connected to the correct USB connection point on your interactive display.

3. Use the remote control input button or the front control panel input button to change the video input until your laptop’s desktop appears on your interactive display screen.

4. Disconnect the USB cable from your laptop, and then connect the auto-launch cable’s USB type A receiver to the USB cable.

   **IMPORTANT**

   If the SMART GoWire auto-launch cable is not connected to your interactive display through a USB cable, you will have access to SMART Meeting Pro software on your laptop for five minutes, and then SMART Meeting Pro software will close.

5. Connect the auto-launch cable’s USB type A connector to a USB receptacle on your laptop.

   SMART software begins activating.

   **NOTE**

   SMART software isn’t being installed on your laptop. It is only activating inside the SMART GoWire auto-launch cable.

6. Select the **Start SMART Meeting Pro** option from the **AutoPlay** dialog box.

   SMART Meeting Pro software opens.

You now have touch control of your laptop’s desktop on your interactive display, and can use SMART Meeting Pro software while your laptop is connected to your interactive display.
To disconnect a SMART GoWire auto-launch cable

1. Save your SMART Meeting Pro software file to your laptop, if required. You can save the file as a .ppt, .pdf or .notebook file.

   **IMPORTANT**
   
   You will only be able to open this file on a computer with SMART Meeting Pro software installed, or one that is connected to a SMART interactive product through a SMART GoWire auto-launch cable.

2. Press the SMART Meeting Pro icon in the notification area, and then press **Exit**.

3. Disconnect the SMART GoWire auto-launch cable from your laptop and your interactive display.
Chapter 7
Maintaining your interactive display

If you properly maintain your interactive display, it will provide years of use.

Updating your SMART Software and firmware
To effectively use both touch control and digital ink on your interactive display, you require SMART software on your computer and up-to-date firmware installed on your interactive display.

Updating SMART Software
Once you have SMART software installed on your computer, you can check for software updates with SMART Product Update by selecting Help > Check for Updates in the software or by browsing to smarttech.com/downloads.

To check for software updates
1. Start your SMART software program.
2. Press Help > Check for Updates.

IMPORTANT
If you don’t see the Check for Updates option, contact your network administrator.
3. Press the **Update** button beside the software you want to update.
   SMART software updates.

---

**IMPORTANT**

When you update SMART software on your computer, a firmware update for your interactive display might download to your computer. The next time you connect your computer to your interactive display, you will be informed that there is a firmware update for the processor in the interactive display. For more information, see page 60.

---

**Updating your interactive display firmware**

---

**CAUTION**

Only a system administrator should update interactive display firmware.

Your interactive display uses firmware located on a processor in the interactive display. After you update SMART software, a new firmware executable file might save on your computer. When you connect a computer with this file to your interactive display, your interactive display detects this executable file, and then prompts you to run the file to update the firmware.

---

**CAUTION**

- Do not disconnect your interactive display from your computer during the firmware update process.
- Do not touch your interactive display screen or input button during the firmware update process.
- Do not turn off your computer or your interactive display during the firmware update process.

---

**To update your interactive display firmware**

1. Ensure your interactive display is connected to your computer.
2. Launch the firmware updater at the following location:
   - Windows computers: `My computer > C > Program Files > SMART Technologies > SMART Product Drivers > SMARTFirmwareUpdater.exe`.
   - Mac computers: `HD\Applications\SMART Product Drivers\SMARTFirmwareUpdater.app`.
3. Follow the Firmware Updater instructions using your computer’s mouse and keyboard. Do not touch your interactive display screen.
4. Select the check box for the SMART interactive product you would like to upgrade by checking the **Update**, and then click **Next**.

A progress bar displays. Once the progress bar reaches 100% the firmware update will be completed.

**IMPORTANT**

SC14 refers to the SB8000 series interactive display’s control panel.

5. Calibrate your interactive display.

**Calibrating your interactive display**

Digital cameras in the corners of the interactive display track the position of the pens, eraser and your finger on the interactive surface, and then send the information to the SMART software, which interprets this information as mouse clicks, digital ink or ink removal in the appropriate location. Calibration determines the position and angles of the cameras to accurately identify touch-location on your interactive display.

**IMPORTANT**

If an error message appears while you are calibrating your interactive display, contact SMART technical support.

**To calibrate your interactive display**

1. Press the SMART software icon (either ☰ or ☯) in the Windows notification area or Mac Dock, and then select **Control Panel**.

   The **Control Panel** appears.

2. Press **SMART Hardware Settings**.

3. If you have more than one SMART product connected, select the interactive display.

4. Select **Advanced Settings** from the drop-down list.

5. Press **Calibrate**.

   The calibration screen appears. This can take a few moments.
6. Press the red target with the tip of a pen tray pen. Hold the tip at the center of the target until the target turns green, and then lift the pen.

The target moves to the next location.

**NOTE**

You can re-calibrate a target by pressing the LEFT ARROW key on your keyboard, or the Keyboard button or Right-click button on the pen tray.

7. Continue pressing targets until the calibration is complete.

A message appears stating that the calibration was successful, and then the orientation screen appears.

8. Orient your interactive display.

**Orienting your interactive display**

When the location of your touch is misinterpreted (a pointer appears a distance from the actual contact), orient your interactive display.

- **To orient the interactive display**
  1. Press the orientation button on the color select module.
     OR
     Complete the calibration process (see page 61).
     The orientation window opens.
  2. Use an interactive display pen to press the red targets as they appear. Hold the tip of the pen at the center of each target until the target turns green, and then lift the pen. When you lift the pen, the target moves to the next orientation point.

**IMPORTANT**

Hold the pen perpendicular to the screen.

3. Continue until you’ve pressed all the targets.

The orientation window closes.

If this does not correct inaccurate touch control, calibrate your interactive display. For more information, see page 61.

**Replacing a pen nib**

To prevent damage to your interactive display’s anti-glare coating, replace your pen nib if it becomes worn. Four replacement pen nibs are included with your pen set, and you can purchase additional replacements from your authorized SMART reseller.
To replace a pen nib

1. Grasp the worn nib on your pen with a pair of pliers, and then pull and twist the nib loose.
2. Press the replacement nib into the pen.

Cleaning the screen

Follow these instructions to clean the interactive display screen without damaging its anti-reflective coating or other product components.

⚠️ CAUTION

- Do not use permanent or dry-erase markers on the screen. If dry-erase markers are used on the screen, remove the ink as soon as possible with a lint-free, non-abrasive cloth.
- Do not rub the screen with a dense or rough material.
- Do not apply pressure to the screen.
- Do not use cleaning solution or glass cleaner on the interactive display screen, as they can deteriorate or discolor the screen.
- Avoid touching the silver reflective tape between the screen and the bezel and ensure that it stays dry. Damage to this strip affects touch interactivity.

To clean the LCD screen

1. Shut off your computer, and then disconnect the power sources for your computer and your interactive display.
2. Wipe the screen with a lint-free, non-abrasive cloth.

Cleaning the camera windows and reflective tape

The DViT technology in your display uses four cameras in the corners of the display and the reflective material between the screen and the bezels. Excessive dust buildup on the camera windows or reflective tape can impair touch performance.

These areas should be inspected annually for dust and should be cleaned if any obvious dust buildup has occurred.
CAUTION

- Do not use compressed air to clean the camera windows or borders.
- Use only water to dampen the cloth. Do not use chemicals or cleaning agents.

To clean the camera windows and reflective tape

1. Lightly moisten a clean lint-free cloth with water.
2. Using the cloth, gently wipe the camera windows in the top corners and the reflective tape along the top of your interactive display screen.
3. Gently wipe the reflective tape along the sides of your interactive display screen.
4. Gently wipe the camera windows in the bottom corners and the reflective strip across the bottom of your interactive display screen.
5. Dry the reflective tape with a clean lint-free cloth.

Maintaining ventilation

Your interactive display requires ventilation to enable the fans to cool the interactive display. Dust buildup in the ventilation holes compromises cooling and leads to product failure.

CAUTION

Avoid setting up or using your interactive display in an area with excessive levels of dust, humidity or smoke.

- Clean accessible ventilation holes with a dry cloth monthly.
- Use a vacuum cleaner with a narrow hose end fitting to clear the back ventilation holes annually. You might have to remove the interactive display from your wall. For more information on removing your interactive display see page 65.

Preventing condensation

Your interactive display screen contains layers of glass that might collect condensation, especially in the following conditions:

- Temperature extremes with high humidity
- Rapid changes in humidity, which might occur when you operate the product near water, such as a sink, pool, kettle or air conditioner ventilator
- Direct exposure to sunlight
CHAPTER 7
Maintaining your interactive display

To evaporate condensation from your interactive display

1. Remove the humidity source from the interactive display, if possible.
2. Adjust the room temperature to normal operating ranges.
3. Turn on the interactive display for 2–3 hours.
4. If the screen condensation does not evaporate, contact SMART Technical Support.

Checking the interactive display installation
Inspect your interactive display installation frequently to ensure that your interactive display remains securely installed.

- Check the mounting location for signs of damage or weakness that can occur over time.
- Check for loose screws, gaps, distortions or other issues that could occur with the mounting apparatus.

If you find an issue, refer to a professional installer.

Removing your interactive display
To safely remove your interactive display, use four or more professional installers.

To remove the interactive display

**IMPORTANT**
Follow the instructions included with the floor stand or mounting apparatus.

1. Turn off your interactive display and unplug the power cable from the wall outlet.
2. Remove all accessible cables and connectors.
3. Attach the M12 eyebolts for your lifting equipment. For more information, see page 10.

**WARNING**
- Do not attempt to move the interactive display using your own strength. The interactive display is very heavy.
- Do not move the interactive display by connecting a rope or wire to its backside handles. It can fall and cause personal injury and product damage.

4. Remove the remaining cables from your interactive display.
5. Lift your interactive display from its mounting location.

![CAUTION]
- Do not leave the interactive display face up, face down or upside down for an extended period of time as it could cause permanent damage to the screen.
- Do not place the interactive display on a sloping or unstable cart, stand or table, because the interactive display could fall resulting in injury or severe product damage.

**Transporting your interactive display**

Save your original packaging so that you can repack your interactive display with as much of the original packaging as possible. This packaging was designed with optimal shock and vibration protection. If your original packaging isn’t available, you can purchase the same packaging directly from your authorized SMART reseller.

![CAUTION]
Transport your interactive display only in original or replaced packaging. Transporting your interactive display without correct packaging voids your warranty and could lead to product damage.
Chapter 8
Troubleshooting for your interactive display

Resolving image issues........................................................................................................... 67
  Diagnosing blank screen issues using the front control panel lights................................. 67
  Resolving poor image quality............................................................................................. 69
Resolving touch control and digital ink issues...................................................................... 70
Resolving audio issues........................................................................................................... 74
Resolving remote control issues............................................................................................ 74
Resolving issues using the SMART Connection Wizard...................................................... 75
Resolving issues using SMART Board Diagnostics............................................................ 75
  Checking the camera view.................................................................................................. 76

This chapter provides you with the information necessary to solve simple issues that might occur
with your interactive display. If issues persist, or are not covered in this chapter, contact SMART
technical support.

Resolving image issues
Complete the following steps if your interactive display doesn’t display an image correctly or
doesn’t display any image at all.

Diagnosing blank screen issues using the front control panel lights
Use the following troubleshooting table when your computer is turned on, but you don’t see an
image on the interactive display screen.

Begin by looking at the display status light in the front control panel located in the lower left corner
of your interactive display.

<table>
<thead>
<tr>
<th>Power light</th>
<th>Status light</th>
<th>Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Off</td>
<td>Your interactive display isn’t connected to a power source.</td>
<td>Connect your interactive display’s power cable to a power outlet (see page 19).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The main power switch is off.</td>
<td>Turn on the main power switch on the terminal panel (see page 3).</td>
</tr>
</tbody>
</table>
### Power light Status light Causes Solutions

<table>
<thead>
<tr>
<th>Power light</th>
<th>Status light</th>
<th>Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid red</td>
<td>Off</td>
<td>Your interactive display is turned off.</td>
<td>Press the power button on the front control panel or the remote control.</td>
</tr>
<tr>
<td>Solid red</td>
<td>Red</td>
<td>Your computer isn’t on.</td>
<td>Turn on your computer.</td>
</tr>
<tr>
<td>Solid red</td>
<td>Flasing green</td>
<td>The interactive display is updating firmware.</td>
<td>Do not touch the interactive display. For more information, see page 59.</td>
</tr>
<tr>
<td>Solid red</td>
<td>Green</td>
<td>The interactive display detects a computer with SMART Product Drivers installed.</td>
<td>Install SMART Software on your computer (see page 25) or install a SMART GoWire autolaunch cable (see page 56).</td>
</tr>
</tbody>
</table>

### Additional Information

- **Solid green**: Normal operation.
- **Solid red**: Off indicates your interactive display is turned off.
- **Solid green**: Solid green indicates the interactive display detects a computer with SMART Product Drivers installed.
- **Solid amber or red**: Solid amber or red indicates your computer isn’t on. Turn on your computer.
- **Solid green**: Flashing amber indicates the interactive display is updating firmware. Do not touch the interactive display. For more information, see page 59.
- **Solid green**: Flashing green indicates the interactive display detects a computer, but SMART Product Drivers are not installed or not running. For more information, see page 70.

For more troubleshooting information, see pages 68-69.
Resolving poor image quality

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Causes</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The image is too large, too small or doesn't completely fill</td>
<td>Your computer’s video resolution settings don’t match your interactive display’s native</td>
<td>Your interactive display’s native resolution is 1920 × 1080 at 60 Hz.</td>
</tr>
<tr>
<td>the screen.</td>
<td>resolution.</td>
<td>If your computer can’t support this resolution, consider one of the following 16:9 resolutions as an alternative:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1600 × 900</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1366 × 768</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1280 × 720</td>
</tr>
<tr>
<td>The screen resolution is correct, but the image is surrounded</td>
<td>Your computer’s video card is underscanning the image.</td>
<td>Turn off or adjust the overscan/underscan feature in the video card driver software until the image fits the screen resolution. Refer to your computer’s video card help for more information.</td>
</tr>
<tr>
<td>by black bars.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>You have a poor quality video cable</td>
<td>1. Replace your video with a better quality video cable.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Press the AUTO SET UP button on your remote to reset your display.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OR</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Select MENU &gt; ADJUST &gt; AUTOSET on the menu control panel (For more information, see page 77).</td>
<td></td>
</tr>
<tr>
<td>You have connected two video cables together.</td>
<td>1. Replace your two cables with one longer cable.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OR</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Relocate your computer so that it’s within a single cable length of your interactive display.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Press the AUTO SET UP button on your remote to reset your interactive display.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OR</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Select MENU &gt; ADJUST &gt; AUTOSET on the menu control panel (For more information, see page 77).</td>
<td></td>
</tr>
<tr>
<td>The image isn’t centered on the screen.</td>
<td>Press the AUTO SET UP button on the remote control.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OR</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Select MENU &gt; ADJUST &gt; AUTOSET on the menu control panel (For more information, see page 77).</td>
<td></td>
</tr>
</tbody>
</table>

1 NOTE

If available, select the HDTV setting (ideally 1080p) from your video card driver’s advanced menu. This should provide a pixel-perfect image for your interactive display.
### CHAPTER 8

Troubleshooting for your interactive display

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Causes</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The image is unstable or unfocused.</td>
<td>Your video connection is loose.</td>
<td>Secure the video cable to both your computer and your interactive display.</td>
</tr>
<tr>
<td>You have a poor quality video cable</td>
<td></td>
<td>1. Replace your video cable with a better quality video cable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Press the AUTO SET UP button on the remote control to reset your interactive display. OR Select MENU &gt; ADJUST &gt; AUTOSET on the menu control panel. (For more information, see page 77).</td>
</tr>
<tr>
<td>You have connected two video cables together.</td>
<td></td>
<td>1. Replace with a single longer cable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OR Move your computer within a single cable length of your interactive display.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Press the AUTO SET UP button on your remote to reset your display.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OR Select MENU &gt; ADJUST &gt; AUTOSET on the menu control panel. (For more information, see page 77).</td>
</tr>
<tr>
<td>You computer's video display card is defective.</td>
<td>Connect a different computer to your interactive display.</td>
<td>If this improves the image quality, consider replacing the video card in the original computer.</td>
</tr>
<tr>
<td>The image is too light, too dark or has poor image quality issues.</td>
<td>You might have incorrect video settings.</td>
<td>Access the on-screen-display menu with the menu button on the remote or the menu button on the menu control panel to adjust picture settings, or select MENU &gt; ADVANCED OPTION &gt; FACTORY PRESET &gt; YES (For more information, see page 77).</td>
</tr>
<tr>
<td>There is a persistent image on the screen.</td>
<td>An image was displayed for too long.</td>
<td>Turn off your interactive display and leave it turned off for as long as the image was on the screen.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>🟢 TIP Use a screen saver to avoid persistent images.</td>
</tr>
<tr>
<td>Other display quality issues</td>
<td>Complete a factory Preset. Select MENU &gt; ADVANCED OPTION &gt; FACTORY PRESET &gt; YES (For more information, see page 77).</td>
<td></td>
</tr>
</tbody>
</table>

**Resolving touch control and digital ink issues**

Use the following troubleshooting table if you can see your computer desktop on your interactive display, but you do not have touch control over the desktop.
## CHAPTER 8
Troubleshooting for your interactive display

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Causes</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>When you touch the screen, no cursor appears and you can't move icons. The status light is red.</td>
<td>No USB connection from the computer to the interactive display.</td>
<td>Ensure you have complete connections (see page 3).</td>
</tr>
<tr>
<td>The SMART Meeting Pro icon or the SMART Notebook icon never appears</td>
<td>Your USB connection is not correct for the selected video connection.</td>
<td>Connect the USB to the correct receptacle that corresponds to your computer’s video connection. For more information, see page 54.</td>
</tr>
<tr>
<td>The SMART Board or SMART Meeting Pro icon is crossed out in red.</td>
<td>SMART Product Drivers software isn’t installed</td>
<td>Download and install SMART software from the smarttech.com/downloads.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Connect your computer or laptop to your interactive display with a SMART GoWire auto-launch cable. For more information, see page 56.</td>
</tr>
<tr>
<td></td>
<td>SMART software isn’t running</td>
<td>Open the SMART Product Drivers folder in your list of programs, and then select SMART Board Tools.</td>
</tr>
<tr>
<td>The SMART Board or SMART Meeting Pro icon is crossed out in red.</td>
<td>Your computer can’t find your interactive display.</td>
<td>Start SMART software, and then run the SMART Connection Wizard’s troubleshooting procedures.</td>
</tr>
<tr>
<td></td>
<td>Either the SMART Board diagnostics window or SMART Board control panel is open.</td>
<td>Close the SMART Board diagnostics window and the SMART Board control panel.</td>
</tr>
</tbody>
</table>
### CHAPTER 8

Troubleshooting for your interactive display

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Causes</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch interactivity is slow or sluggish.</td>
<td>Your computer is running too many applications.</td>
<td>Close some open applications.</td>
</tr>
<tr>
<td></td>
<td>Your computer doesn't meet system requirements.</td>
<td>Upgrade your computer or replace it with a more powerful computer.</td>
</tr>
<tr>
<td></td>
<td>You haven't used a USB 2.0 cable to connect your interactive display to your computer.</td>
<td>Use a USB 2.0 cable and ensure it is connected to a USB 2.0 connector on your computer.</td>
</tr>
<tr>
<td>When you touch the screen the cursor appears in the wrong location.</td>
<td>You aren't touching the screen at right angles.</td>
<td>For more information, see <em>Touching and Drawing on Your SMART Board Interactive Whiteboard is Inaccurate</em> (smarttech.com/kb/131299) for more information.</td>
</tr>
<tr>
<td></td>
<td>Your interactive display isn't oriented.</td>
<td>Orient your interactive display. Press the orient button on the color select module, and then follow the on-screen instructions. For more information, see page 62.</td>
</tr>
<tr>
<td></td>
<td>Your desktop isn't centered on the screen.</td>
<td>Press the <strong>AUTO SET UP</strong> button on your remote to reset your display.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>OR</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select <strong>MENU &gt; ADJUST &gt; AUTOSET</strong> on the menu control panel. For more information, see page 77.</td>
</tr>
</tbody>
</table>

**IMPORTANT**

You might have to do this more than once.
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Causes</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>An area of the screen doesn’t respond to your touch or when you draw digital ink, the lines are broken.</td>
<td>Something is blocking the cameras.</td>
<td>Ensure nothing is taped to the screen.</td>
</tr>
<tr>
<td></td>
<td>Something is sitting on the reflective tape inside the camera channel.</td>
<td>Remove items from the camera channel.</td>
</tr>
<tr>
<td></td>
<td>Your finger or pen is skipping as you draw. This is most common on the upstroke.</td>
<td>Use consistent pressure while drawing digital ink.</td>
</tr>
<tr>
<td></td>
<td>Bright lights are interfering with the cameras.</td>
<td>Close any blinds and shades or dim all halogen lights and LEDs.</td>
</tr>
<tr>
<td></td>
<td>Your cameras require calibration, possibly due to temperature change in the room.</td>
<td>Refer to the calibration instructions on page 61.</td>
</tr>
<tr>
<td>You try to erase using a large object, but you draw more digital ink. One of the color select button lights is flashing.</td>
<td>You’re in Locked Ink mode and objects are considered pens.</td>
<td>Press a non-flashing color select button to exit Locked Ink mode. OR Remove the eraser from the eraser holder to enable erasing while in Locked Ink mode.</td>
</tr>
<tr>
<td>You try to erase with the eraser, but you draw more digital ink. You do not see a flashing light on the color select module.</td>
<td>You are using an edge of the eraser.</td>
<td>Increase the contact area of your eraser.</td>
</tr>
<tr>
<td>You are trying to draw digital ink, but you see a circle beneath your pointer and you are erasing digital ink.</td>
<td>Your interactive display is interpreting an eraser.</td>
<td>Lift other fingers and the heel of your hand from the interactive display while you write because the interactive display is interpreting them as an eraser. OR Use a smaller pointer, such as the pen.</td>
</tr>
</tbody>
</table>
Resolving audio issues

**IMPORTANT**

Ensure you can see your computer’s desktop and have both touch control and digital ink before using this table. If not, resolve those issues before completing the following steps in the table below.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Causes</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sound doesn’t play when you play a sound file.</td>
<td>Your computer is muted.</td>
<td>Turn off the mute setting.</td>
</tr>
<tr>
<td></td>
<td>Your computer’s volume is too low.</td>
<td>Turn up the volume on your computer.</td>
</tr>
<tr>
<td></td>
<td>Your interactive display is muted.</td>
<td>Turn off the mute setting using the remote control or the control panel.</td>
</tr>
<tr>
<td></td>
<td>Your interactive display’s volume is too low.</td>
<td>Use the remote to turn up the volume on your interactive display. OR Use the volume control on the front control panel.</td>
</tr>
<tr>
<td></td>
<td>Your computer uses Mac operating system software and is not set to Audio USB output.</td>
<td>Set your computer’s audio output to USB. For more information, see page 50.</td>
</tr>
</tbody>
</table>

Resolving remote control issues

Your remote control provides control of your interactive display from 23’ (7 m) of the front control panel of your interactive display.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Causes</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The remote control behaves unexpectedly. The front control panel power button light is off.</td>
<td>Your interactive display isn’t receiving power.</td>
<td>Ensure your interactive display is plugged in and ensure the master power switch on the bottom terminal panel is in the ON position. For more information, see page 3.</td>
</tr>
<tr>
<td>Your remote control behaves unexpectedly.</td>
<td>You are outside the range of the infrared remote control sensor.</td>
<td>Move to within 23’ (7 m) and a 30º arc of your infrared remote control sensor.</td>
</tr>
</tbody>
</table>
### Resolving issues using the SMART Connection Wizard

You can resolve a variety of troubleshooting issues using the SMART Connection Wizard found in the SMART control panel.

#### To start the SMART Connection Wizard

1. Press the **Help** button on the color select module.
   
   The *Help and Support for Your SMART Board Interactive Whiteboard* window opens.

2. Press **Connection Wizard**.
   
   The *SMART Connection Wizard* opens.

   **NOTE**

   You can also access the SMART Connection Wizard by selecting the **SMART Board icon** in the Windows notification area or Mac Dock, selecting **Control Panel**, and then selecting **Connection Wizard**.

3. Select **SMART Board 8000 series interactive display**, and then press **Next**.

4. Select the option that best describes the issue you’re encountering, and follow the on-screen instructions to troubleshoot your interactive display.

### Resolving issues using SMART Board Diagnostics

If you touch the interactive display’s surface and nothing happens, or if there is no digital ink or the ink appears in some locations and not in others, use SMART Board Diagnostics to help

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Causes</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The remote control batteries need replacement.</td>
<td>Replace the batteries. For more information, see page 31.</td>
<td></td>
</tr>
<tr>
<td>The remote control is damaged.</td>
<td>Contact your authorized SMART reseller to enquire about a replacement remote control.</td>
<td></td>
</tr>
<tr>
<td>Something is plugged into the wired remote control receptacles on the audio connection panel, which is disabling the remote control.</td>
<td>Unplug the connector from the wired remote control receptacles. For more information, see page 16.</td>
<td></td>
</tr>
</tbody>
</table>
identify and resolve these issues.

**IMPORTANT**
Do not change diagnostic settings unless asked to do so by SMART Technical Support.

**Checking the camera view**
If nothing happens when you touch the interactive display’s surface, check to make sure that nothing is obscuring one of the cameras’ views.

**To check camera views**
1. Press the **SMART Board** icon in the Windows notification area or Mac Dock, and then press **Control Panel**.
   The SMART control panel opens.
2. Select **About Software and Product Support > Tools > Diagnostics**.
   The **SMART Board Diagnostics** screen opens.
3. In the **View** menu, select **SBX800/SBID8070i Bar**.
   The SBX800 group box appears in the **SMART Board Diagnostics** screen.
4. Press **View**.
   The camera view screen appears.
5. Click **Update** to display the four cameras views. This could take a few moments.
   If one of the camera’s views remains black, the camera is obstructed or can’t locate the reflective surface on the interactive display’s inner frame.
6. Check the camera lens and ensure that nothing is obstructing its view and that nothing is affixed to the interactive surface.
Appendix A

Adjusting video settings with the on-screen display menu

Changing settings in the on-screen display menu .......................................................... 77
Main menu settings .......................................................................................................... 78
  PICTURE settings ........................................................................................................... 78
  ADJUST settings ........................................................................................................... 79
  AUDIO settings ............................................................................................................ 79
  SCHEDULE settings ....................................................................................................... 80
  PiP (Picture in Picture) settings .................................................................................... 80
  OSD (On Screen Display) settings .................................................................................. 81
  MULTI DISPLAY settings ............................................................................................... 82
  DISPLAY PROTECTION settings .................................................................................... 83
  ADVANCED OPTION settings ......................................................................................... 84

You can access the on-screen menu using either the remote control (see page 33) or the menu control panel on the left side of the interactive display (see page 5).

Changing settings in the on-screen display menu

You can adjust many of the interactive display screen settings using the on-screen menu.

To change settings in the on-screen display menu

1. Press the MENU button on the menu control panel or the remote control.
   The on-screen menu appears.
2. Press the up and down arrows to browse to the setting you want to change.
3. Press SET.
4. Press the up and down arrows to browse to the setting you want from the sub-menu.
   OR
   Press the + button to increase or the - button to decrease the value.
5. If you want to change another setting, press the EXIT button to return to the main menu, and then repeat steps 2–4.

6. When you finish changing settings, press the MENU button to close the on-screen menu.

Main menu settings

**PICTURE settings**

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>BRIGHTNESS</td>
<td>Adjusts the overall brightness of the image and background.</td>
</tr>
<tr>
<td></td>
<td>![NOTE] You can't change this setting when picture mode is set to AMBIENT1 or AMBIENT2.</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>Adjusts the brightness of the image in relation to the background. The sRGB picture mode is standard and cannot be changed.</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>Adjusts the sharpness of the image.</td>
</tr>
<tr>
<td>BLACK LEVEL</td>
<td>Adjusts the brightness of the image brightness in relation to the background. The sRGB picture mode is standard and cannot be changed.</td>
</tr>
<tr>
<td>TINT</td>
<td>Adjusts the tint of the screen.</td>
</tr>
<tr>
<td>COLOR</td>
<td>Adjusts the color depth of the screen.</td>
</tr>
<tr>
<td>COLOR TEMPERATURE</td>
<td>Adjusts the color temperature of the entire screen. The sRGB picture mode is standard and cannot be changed.</td>
</tr>
<tr>
<td>COLOR CONTROL</td>
<td>Adjusts the levels of the Red, Yellow, Green, Cyan, Blue, Magenta and Saturation. The sRGB picture mode is standard and cannot be changed.</td>
</tr>
<tr>
<td>GAMMA SELECTION</td>
<td>Selects a display gamma for best picture quality. The sRGB picture mode is standard and cannot be changed.</td>
</tr>
<tr>
<td>MOVIE SETTING</td>
<td>Sets NOISE REDUCTION, FILM MODE and ADAPTIVE CONTRAST.</td>
</tr>
<tr>
<td>PICTURE MODE</td>
<td>Sets picture mode to HIGHBRIGHT, STANDARD, sRGB, CINEMA, AMBIENT1 or AMBIENT2.</td>
</tr>
<tr>
<td>PICTURE RESET</td>
<td>Restores the picture settings to their default values.</td>
</tr>
</tbody>
</table>
## ADJUST settings

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO SETUP</td>
<td>Adjusts Screen Size, H position, V position, Clock, Clock Phase and White Level automatically.</td>
</tr>
<tr>
<td>AUTO ADJUST</td>
<td>Sets H Position, V Position and Clock Phase to adjust automatically when your interactive display is turned on.</td>
</tr>
<tr>
<td>H POSITION</td>
<td>Controls the horizontal position of the image within the display area.</td>
</tr>
<tr>
<td>V POSITION</td>
<td>Controls the vertical position of the image within the display area.</td>
</tr>
<tr>
<td>CLOCK</td>
<td>Adjusts the width of the image.</td>
</tr>
<tr>
<td>CLOCK PHASE</td>
<td>Adjusts the visual noise on the image.</td>
</tr>
<tr>
<td>H RESOLUTION</td>
<td>Adjusts the horizontal size of the image.</td>
</tr>
<tr>
<td>V RESOLUTION</td>
<td>Adjusts the vertical size of the image.</td>
</tr>
<tr>
<td>INPUT RESOLUTION</td>
<td>Displays the signal at the desired resolution. After selecting this, use the AUTO SETUP option above.</td>
</tr>
<tr>
<td>ZOOM MODE</td>
<td>Selects the aspect ratio of the screen image.</td>
</tr>
<tr>
<td>ASPECT</td>
<td>Sets picture aspect to FULL, NORMAL, TRIM or ZOOM.</td>
</tr>
<tr>
<td>ADJUST RESET</td>
<td>Restores the adjust settings to their default values.</td>
</tr>
</tbody>
</table>

## AUDIO settings

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>BALANCE</td>
<td>Adjust the balance of left and right volume.</td>
</tr>
<tr>
<td>TREBLE</td>
<td>Adjusts the high frequency sound.</td>
</tr>
<tr>
<td>BASS</td>
<td>Adjusts the low frequency sound.</td>
</tr>
<tr>
<td>PIP AUDIO</td>
<td>Selects the sound source when in PIP mode.</td>
</tr>
<tr>
<td>LINE OUT</td>
<td>Selects FIXED or VARIABLE audio line out.</td>
</tr>
<tr>
<td>SURROUND</td>
<td>Sets artificial surround sound.</td>
</tr>
<tr>
<td>AUDIO INPUT</td>
<td>Sets audio input source to IN1, IN2, IN3, HDMI or TV.</td>
</tr>
<tr>
<td>AUDIO RESET</td>
<td>Restores the audio settings to their default values.</td>
</tr>
</tbody>
</table>
## APPENDIX A
Adjusting video settings with the on-screen display menu

### SCHEDULE settings

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF TIMER</td>
<td>Sets the length of the auto power-off after a period of time with no input. You can set this from 1–24 hours.</td>
</tr>
<tr>
<td>SCHEDULE SETTING</td>
<td>Creates a working schedule for the interactive display to use.</td>
</tr>
<tr>
<td></td>
<td><strong>IMPORTANT</strong></td>
</tr>
<tr>
<td></td>
<td>You must set the date and time values before you can set a schedule.</td>
</tr>
<tr>
<td>SCHEDULE LIST</td>
<td>Displays the interactive display’s schedules.</td>
</tr>
<tr>
<td>DATE &amp; TIME</td>
<td>Sets the date, time, time zone and daylight savings time settings.</td>
</tr>
<tr>
<td>SCHEDULE RESET</td>
<td>Restores the schedule settings to their default values.</td>
</tr>
</tbody>
</table>

### PiP (Picture in Picture) settings

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>KEEP PiP MODE</td>
<td>Enables the interactive display to remain in PiP and TEXT Ticker modes after it’s turned off and turned on again.</td>
</tr>
<tr>
<td>PiP MODE</td>
<td>Sets the sub-picture mode to PiP, POP, SBS aspect or SBS full.</td>
</tr>
<tr>
<td>PiP SIZE</td>
<td>Selects the size of the sub-picture used in PiP mode.</td>
</tr>
<tr>
<td>PiP POSITION</td>
<td>Determines where the PiP appears on the screen.</td>
</tr>
<tr>
<td>ASPECT</td>
<td>Selects sub picture aspect. Options are FULL, NORMAL, WIDE and ZOOM.</td>
</tr>
<tr>
<td>TEXT TICKER</td>
<td>Allows text insertion within main screen with the ability to adjust.</td>
</tr>
<tr>
<td>SUB INPUT</td>
<td>Selects sub picture input signal.</td>
</tr>
<tr>
<td>PiP RESET</td>
<td>Restores the PiP settings to their default values.</td>
</tr>
</tbody>
</table>
# APPENDIX A

Adjusting video settings with the on-screen display menu

## OSD (On Screen Display) settings

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>LANGUAGE</td>
<td>Selects the language used by the on-screen display menu.</td>
</tr>
<tr>
<td>OSD TURN OFF</td>
<td>Turns off the on-screen display menu after a period of inactivity. The preset choices are 10–240 seconds.</td>
</tr>
<tr>
<td>OSD POSITION</td>
<td>Sets where the on-screen display menu appears on the screen to Left or Right.</td>
</tr>
<tr>
<td>INFORMATION OSD</td>
<td>Selects if the Information on-screen display menu is displayed.</td>
</tr>
<tr>
<td>MONITOR INFORMATION</td>
<td>Displays interactive display information.</td>
</tr>
<tr>
<td>CARBON SAVINGS</td>
<td>Displays the estimated carbon saving information in kilograms.</td>
</tr>
<tr>
<td>OSD TRANSPARENCY</td>
<td>Sets the transparency level of the on-screen display menu.</td>
</tr>
<tr>
<td>OSD ROTATION</td>
<td>Sets the on-screen display menu display direction to landscape or portrait.</td>
</tr>
<tr>
<td>INPUT NAME</td>
<td>Sets currently displayed INPUT name. Maximum length is 8 letters, and you can use spaces, letters from A-Z, numerals from 0-9 and some symbols.</td>
</tr>
<tr>
<td>CLOSED CAPTION</td>
<td>Activates closed captioning.</td>
</tr>
<tr>
<td>OSD RESET</td>
<td>Restores the OSD settings to their default values.</td>
</tr>
</tbody>
</table>
## MULTI DISPLAY settings

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>MONITOR ID</td>
<td>Sets the monitor ID number from 1–100 and group ID from A–J.</td>
</tr>
<tr>
<td>IR CONTROL</td>
<td>Selects the mode of the interactive display for use with the remote control when using the RS-232C daisy chain.</td>
</tr>
<tr>
<td>TILING</td>
<td>Allows an image to be expanded and displayed on multiple screens (up to 100) through a distribution amplifier.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong></td>
</tr>
<tr>
<td></td>
<td>Use a high resolution when tiling an image to multiple monitors.</td>
</tr>
<tr>
<td>POWER ON DELAY</td>
<td>Adjusts the delay time between being in Standby mode and entering Power on mode. The POWER ON DELAY can be set between 0 and 50 seconds.</td>
</tr>
<tr>
<td>POWER INDICATOR</td>
<td>Turns ON or turns OFF the power indicator light. If you select OFF, the power indicator light will not turn when the interactive display is in Active mode.</td>
</tr>
<tr>
<td>EXTERNAL CONTROL</td>
<td>Sets the control interface to RS-232C or LAN.</td>
</tr>
<tr>
<td>SETTING COPY</td>
<td>Sets the on-screen display menu categories that copy from the current monitor to additional monitors that are connected in a daisy-chain configuration. SETTING COPY settings reset to default when the interactive display is turned off.</td>
</tr>
<tr>
<td></td>
<td><strong>IMPORTANT</strong></td>
</tr>
<tr>
<td></td>
<td>• Set EXTERNAL CONTROL to RS-232C to use this function.</td>
</tr>
<tr>
<td></td>
<td>• This function is limited to five additional monitors.</td>
</tr>
<tr>
<td>MULTI DISPLAY RESET</td>
<td>Restores the Multi display settings to their default values.</td>
</tr>
</tbody>
</table>
### DISPLAY PROTECTION settings

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER SAVE</td>
<td>Sets how long the interactive display waits to go into Power Save mode after a lost signal.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>When you connect a DVI video cable, the video card might not stop sending digital data even if there is no image. In this case the interactive display doesn't enter Power Save mode.</td>
</tr>
<tr>
<td>STANDBY MODE</td>
<td>Lowers power consumption.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>You can't use RS-232C and LAN Functions in Eco Standby mode.</td>
</tr>
<tr>
<td>HEAT STATUS</td>
<td>Displays the FAN, BRIGHTNESS and TEMPERATURE settings.</td>
</tr>
<tr>
<td>FAN CONTROL</td>
<td>Sets the cooling fan to protect the interactive display from overheating. If you select, you can adjust the start temperature of the cooling fan and its speed.</td>
</tr>
<tr>
<td>SCREEN SAVER</td>
<td>Sets a SCREEN SAVER to reduce the risk of a persistent image.</td>
</tr>
<tr>
<td>SIDE BORDER COLOR</td>
<td>Adjusts the color of the borders that appear when a 4:3 image is displayed.</td>
</tr>
<tr>
<td>AUTO BRIGHTNESS</td>
<td>Adjusts the brightness level according to the input signal.</td>
</tr>
<tr>
<td><strong>NOTE</strong></td>
<td>Do not select this function when the picture mode is set to AMBIENT1 or AMBIENT2.</td>
</tr>
<tr>
<td>CHANGE SECURITY PASSWORD</td>
<td>Enables you to change the security password. The preset password is 0000.</td>
</tr>
<tr>
<td>SECURITY LOCK</td>
<td>Locks the security password.</td>
</tr>
<tr>
<td>DDC CI</td>
<td>ENABLE/DISABLE: turns on or off the two-way communication and control of the interactive display.</td>
</tr>
<tr>
<td>DISPLAY PROTECTION RESET</td>
<td>Restores the Display protection settings to their default values.</td>
</tr>
</tbody>
</table>
## APPENDIX A
Adjusting video settings with the on-screen display menu

### ADVANCED OPTION settings

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>INPUT DETECT</td>
<td>Selects the method of input detection the interactive display uses when more than two input devices are connected.</td>
</tr>
<tr>
<td>INPUT CHANGE</td>
<td>Sets input change speed.</td>
</tr>
<tr>
<td>NOTE</td>
<td>When QUICK is selected, the image might be distorted when the input signal changes.</td>
</tr>
<tr>
<td>LONG CABLE COMP</td>
<td>Manually compensates for image degradation caused from using a long cable.</td>
</tr>
<tr>
<td>TERMINAL SETTING</td>
<td>Sets DVI MODE, BNC MODE, SCART MODE and HDMI SIGNAL.</td>
</tr>
<tr>
<td>SCAN CONVERSION</td>
<td>Selects the IP (Interface to Progressive) conversion function.</td>
</tr>
<tr>
<td>NOTE</td>
<td>For DVI inputs, set the DVI MODE menu to DVI-HD.</td>
</tr>
<tr>
<td>COLOR SYSTEM</td>
<td>Sets the color system, depending on the video format of the input signal.</td>
</tr>
<tr>
<td>SCAN MODE</td>
<td>Sets the scanning mode. Some video formats might require different modes to display the best image.</td>
</tr>
<tr>
<td>ADVANCED OPTION RESET</td>
<td>Restores the advanced option settings to their default values.</td>
</tr>
<tr>
<td>FACTORY PRESET</td>
<td>Restores OSD options back to default values for all items, except for DATE &amp; TIME, LANGUAGE, OSD ROTATION, INPUT NAME, CHANGE SECURITY PASSWORD, SECURITY LOCK and SECURITY PASSWORD.</td>
</tr>
</tbody>
</table>
Appendix B

Hardware environmental compliance

SMART Technologies supports global efforts to ensure that electronic equipment is manufactured, sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment regulations (WEEE directive)
Waste Electrical and Electronic Equipment regulations apply to all electrical and electronic equipment sold within the European Union.

When you dispose of any electrical or electronic equipment, including SMART Technologies products, we strongly encourage you to properly recycle the electronic product when it has reached end of its life. If you require further information, please contact your reseller or SMART Technologies for information on which recycling agency to contact.

Restriction of Certain Hazardous Substances (RoHS directive)
This product meets the requirements of the European Union’s Restriction of Certain Hazardous Substances (RoHS) directive 2002/95/EC.

Consequently, this product also complies with other regulations that have arisen in various geographical areas, and that reference the European Union’s RoHS directive.

Batteries
Batteries are regulated in many countries. Check with your reseller to find out how to recycle used batteries.

There are special regulations that must be met when shipping a product that has a lithium ion battery packaged with the product or shipping a lithium ion battery. When returning a SMART Technologies
product which contains a lithium ion battery or returning a lithium ion battery, call SMART Technologies RMA for information on these special shipping regulations:

- 1.866.518.6791, Option 4 (U.S./Canada)
- 1.403.228.5940 (all other countries)

Packaging
Many countries have regulations restricting the use of certain heavy metals in product packaging. The packaging used by SMART Technologies to ship products complies with applicable packaging laws.

Covered electronic devices
Many U.S. states classify monitors as covered electronic devices and regulate their disposal. Applicable SMART Technologies products meet the requirements of the covered electronic devices regulations.

China’s Electronic Information Products regulations
China regulates products that are classified as EIP (Electronic Information Products). SMART Technologies products fall under this classification and meet the requirements for China’s EIP regulations.

U.S. Consumer Product Safety Improvement Act
The United States has enacted the Consumer Product Safety Improvement Act which limits the lead (Pb) content in products used by children. SMART Technologies is committed to complying with this initiative.